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To install Snow Leopard, insert your installation disk and double-click Install Mac OS X,
then follow the onscreen instructions.

ano () Mac 05 X Install DVD

3 tems, 16 K8 avaiable

p 4

Install Mac 05 X

Qno, Install Mac 05 X

Install Mac OS X

To set up the installation of Snow Leopard, click Continue.

Click here to repair ————Cusiies Cotack ) (Continue )
your startup disk or
restore from a backup.

To restore your computer’s software, see the user guide that came with your computer.



When you're ready, click Install to begin installing Mac OS X Snow Leopard. When the
installation is finished, your computer will restart.

Q00 Install Mac S X

Install Mac OS X

Mac OS X will be installed on “Macintosh HD"

Macintosh HD.

Customize... ) (_Go Back (sl

Click Customize if you want
to change what's installed.

For additional information, see the Instructions folder on your installation disc.



Meet Snow Leopard

www.apple.com/macosx
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The Dock includes the Documents, Downloads, and Applications stacks. Stacks provide
a convenient way to get to documents and applications. To create a stack, drag a folder
to the Dock.

Allen Fishing Green Grocery City Poster

@)

Italian Architecture Surfing Open in Finder

When you click a stack,
the items in it appear in
a grid, fan, or list.




Downloads stack
Items you download in Safari, Mail, or iChat always go to the Downloads stack so that
you can find them quickly.
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PACES

The latest download
appears here.

Click the Downloads stack to
see items you've downloaded.

8 Desktop



Stacks automatically appear as a fan or a grid, based on the number of items in the stack.
You can specify which style you want to use and change the stack’s sort order.

v Name
Date Added
Date Modified
Date Created
Kind

Folder
v Stack

v Fan
Grid
List
Automatic

Remove from Dock
Show in Finder

Open “Downloads”

To customize a stack, press the
Control key and click the stack’s icon.



Use Exposé from the Dock at any time to quickly view the windows open in an

application and bring one to the front.

— To see a full-size
preview of a
window, highlight
it and press the
Space bar.

Click and hold the application icon to
view open windows in Exposé.
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Cover Flow lets you flip through your movies, presentations, PDF files, and more in
large-size previews.

(1 Documents o

Click this button
for Cover Flow.

(S)Remote Disc 4 | |

¥ SHARED

Move the pointer over
an item to play a movie
or see the pages of a
(<)) document, for example.

Milea Real Estate

v ruaces
Desicon
@ anncjohnson
/A Applications

MILEA REAL ESTATE

¥ SEARCH FOR

Drag the slider to

o et Wodred — )
Baiores 5 e g Ay 16,2008 1048 M 172we T mage flip through your
& Acthe Lake Jly 16,2009 2:42 1172w T mage
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[% City Symphony Poster June 28, 2009 2:35 PM 905KB  Portable Document Format (PDF)
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£ Famiy Newsleter Vesterday, 530 4715 Porable Network Graphis mage
Green Grocery Newsleter Vesterday, 632 PM 4108 Fages Document
i hori 22,2009 105 7.2M5__rages Document
e esterdar, 632 P 35:2 M8 Keynote Dotument .
= School Newsletter Yesterday, 6:33 PM 262KB  Pages Document 0

L0f 15 selected, 183.83 G avaiable.
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Sidebar
The Finder sidebar makes it easy to get to folders on your computer, shared computers on
your network, and your saved searches.

¥ DEVICES

=] Macintosh HD
E iDisk
E Backup

@ Remote Disc

» 1>

¥ suaren ————— Shared computers
B Mom's Mac available on your network
881 Gill's MacBook automatically appear here.
& A

¥ PLACES
I Deskiop
ﬁ} annejohnson
ﬁ Applications
B Documents

¥ searcH ror ——————Commonly used searches are

() Today included in the sidebar, and you

(2 Yesterday can add your own searches.
() Past Week
(& All Images
[& All Movies
[ All Documents

14 Finder



In a Finder window or the menu bar, use Spotlight to search for items on your computer. If
you use the same search often, save it in the Search For section of the sidebar.

enn

& Searching “Documents” =)
(-] BRI - astoolwe _____——Type your search here.
o View Qitook_cion seacn
¥ DEVICES Search:  This Mac Shared Save ) (+)

2 Macintosh HD.
B Click Save to add a

Disas = Smart Folder to the
B , sidebar.

80 oaa's b
@ an

¥ SHARED

v pLaces

Hoo [EEEEELE 0 W See your search results
e i — in Cover Flow.

[
g i Science Report

Oroday

Pages Document
© vesterday
© Past Week

35 Al images. Date Modified Size | Kind
8 Al Movies W Away from School Jul 16, 2009, 2:40 PM 1ILEME  TIFF image
(&8 Al Documents # Fishing Trip Jul 16, 2009, 10:44 AM 111.5M8  TIFF image

Letter to Parents 136KE  Pages Document

B Science Report 192 KB__Pages Document
1ILEME  TIFF image

Welcome Back Aug 24, 2009, 601 PM 256K8  Pages Document

A annejohnson + [l Documents +  Science Report

1016 selected
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Shared computers on your network automatically appear in the sidebar so that you can
quickly find documents they contain.

=
—— Search for documents

on shared computers.

(1 Bill's MacBook

v Devices
S
Elipisk
ST
) Remote Disc &

» suanep
28 o e

8/ Dac'sC
@ .

v races
B veskeop
4 annejonnson
7\ Applications
3 Documents

¥ SEARCH FOR

) Today

 Dat Modifed Sze | Kind — Get immediate access

38 A Movies July 16, 2009 10:44 AM 117.2M8  TIFF image
8 A1l Documents July 16, 2009 2:40 PM 117.2M5  TIFF image to the Public folder on
olin Rafiing Trip Today, 11:52 AM - Numbers document

Famiy Newsttter 471 KB Portable Nework Graphics mage

& st 26,209 58 o T mae any shared computer.
@ Surfng September 16,2009 1245 M 49.9MB  TIFF image

@ Surfing Hawaii July 26, 2009 3:01 PM 117.2MB  TIFF image




Use screen sharing to get to the desktop of shared computers on your network. You can

monitor use, change settings, and much more all from your computer.

] Marta's Mac

i Macintosh HD.
3 gackup
%) Remote Disc

 SHARED

I Marta's Mac

Deskaon

@ annejonnson
A Appiicatons
[ Documents
¥ SeARCH FOR
© Today

© vesterday
© pastweek
(A mages
0 A Movies:

(@8 Al Documents

OF)

1OROSBRaT

Y

|To use all of your screen, click
the Full-Screen button.

Select the computer in
L o vew » - Search. e R

Foeiie the sidebar and then
Eliou click Share Screen.

To see the screen
sharing toolbar,
choose View >
Show Toolbar
from the menu.

You see the
desktop of the
other computer
in a window.
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Sharing
You can share your files, your website, your screen, and much more with other computers
on your network. To start, open System Preferences and then click Sharing.

Sharing

Computer Name: | Anne Johnson's MacBook Pro

Computers on yourlocal petwork can access yur ompater at: Ann-
Jomnions Mackool Moloca

OnService © File Sharing: On
& VD or CO Sharing Other users can acces shared folders on this computer,
and scministators il vlumes, 3t 3fp://17.244 41,162/
o “Anne Jahnson's MacBook o',
Scanner Sharing Shared Folders: Users:
Web Sharing [iAnne john. biic Folder | | & Anne Johnson  Read & Write ¢
Remote Login 3 Cathy's Public Folder | | 38.staff Read Only
[ Remote Management (aMara's Public Folder || {8 Everyone Read Only
Remote Apple Events msusan's Publc Folder -
Xgrid Sharing

B saaos g — Click this Add (+) button
B e to select users and groups
who can share your files.

ﬂ] Click the lock to prevent further fhanges. @

Click this Add (+) button
to select any folder you
want to share.

18 Finder



Back to My Mac

With your MobileMe subscription, an Internet connection, and Back to My Mac and

sharing turned on, you can access any of your computers from anywhere on the Internet.

D

© Back to My Mac: On

Using Back to My Mac you can access this computer, and services such s file sharing and
screen sharing, from your other computers that have Back to My Mac enabled.

compuner from ather computrs ustng ack t y Hac

MobileMe is the simple way to keep everything in sync on your Mac, PC, iPhone, and
iPod t

Account |_Sync | iDisk

with Back To My Mac.

e A (opensharng )

“Wake for network access" so that
Back to My Mac can wake this computer from sleep. i )

¥ DEvICES

wscmosn o
Eliois
Elsackup

Back to My Mac computers —— e v
appear in the sidebar. ?..,-..E. -

»

© Remate Disc

¥ SHARED

Y PLACES Library
1 pesop
4 annejohnson

¥ SEARCH FOR
© Today Pictures
© vesterday
(© Past Week.

M Applications
[ pecuments

Back to My Mac is
on automatically.

Documents

Moves.

Public

Downloads

Music

sites

Finder

19



20

Quick Look

cument Format (706

Poratie Oocumers Farmat (FOF)




You can use Quick Look in the Finder, Time Machine, and Mail. To view an item in
Quick Look, select it and then press the Space bar.

L1 Documents =)

Click the Quick Look
= button in the Finder
et : window toolbar.

Elacan &
(%) Remote Disc &
v siAReD
8 vor's Mac
B gilr's MacBook
8/0ac's e
®an..
vruaces
B oesiop
4 amnciohnson
/A Applications.
B Documents
¥ searci For
ody Family New
esterday

© past week

0 ATl images

8 Al Movies

8 Al Documents & Allen Fishing July 16, 2009 10:44 A
= Atthe Lake July 16, 2009 2:42 PM
B Canoeing July 16, 2009 2:40 PM
[ City symphony Poster June 28, 2009 2:35 PY

ollin Rafting Trip May 21, 2009 705 P
Iy September 16, 2009 1
[
reen Grocery Newsletter May 21, 2009 6:32 PV
 Milea Brochure April 22, 2009 1:09 P
3 Milea Real Estate May 21, 2009 6:32 P
= Schaol Newsler Mav 21 2009 6:33 B
Lof 15 selected,

Click here for a

full-screen preview.
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Browse contents
When you view documents in Quick Look, you can flip through each page of your
document or view each slide of a Keynote presentation.

talian Architecture

COLOSSEUM
ELEVATION DETAIL

Each slide of a Keynote
presentation appears here.

22 Quick Look



You can use Quick Look to view several items at once. To automatically scan through the
items, click the Play button.

Click an item in the
index sheet to view it.

Click the Index Sheet Click the Camera button
button to view all the items. to add a photo to iPhoto.

23
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Time Machine




To start using Time Machine, just connect a FireWire or USB disk or a Time Capsule to your
computer, and then click “Use as Backup Disk” in the dialog that appears.

When you turn on Time
Machine, it backs up your
computer to the disk
you've selected.

25
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Easily find a missing document by seeing how your desktop looked in the past. Time
Machine does a backup each hour of the current day, and then saves daily backups.

Type in the search
field to look for
a document.

Click the back
arrow to go back

in time.
Use Quick Look to Browse items in When you find the
check a document your backup using document, select it and
before you restore it. Cover Flow. then click Restore.



Set Time Machine preferences
To set Time Machine options, open Time Machine preferences. You can select a different
backup disk or specify folders or disks you don’t want to include in your backups.

Name: BackUp.
o Available: 182.2 GB of 232.9 G
Oldest Backup: 6/16/09 4:57 PM

| Change Disk-. | - 41qqt gackup: 8/27/09 3:08 PM
| Options... | Next Backup: 8/27/09 4:13 PM
L Optons.-

Click Options to select items
T 1 Time Machine kee
lime Machine b you don't want to back up.

« Hourly backups for the past 24 hours
« Dally backups for the past month.
= Weekly backups until your backup disk is full

orf Ml ) ON | e e hn o ik bl

¥ Show Time Machine status in the menu bar

!l the tock o prevent uther changes. ®

Time Machine 27



Exchange
Mail, iCal, and Address Book support Microsoft Exchange to
access your work email, calendars, and contacts.

Srhon e
sy s

28 Exchange



Mail

To start using Exchange, just enter your Exchange email address and password, and Mail
does the rest for you. Snow Leopard automatically sets up iCal and Address Book, too.

¥ SMART MAILBOXES.

e

¥ EXCHANGE

»Mnm o

Quick Favor

5/13/09

Trbeca Grand otel Horel Reservation si/0 s 18P
Darine weaver Job Opening in Marketing s/13/00 5267
Corus e 775 Report si3/09 s27em
Lynerte aito Contact nfo s/13/09 520
Chuck ersay Ride from the Aport 513009 s30m

5/13/00_534P
/13700617 7m
tato 5113/09 619FM 5
Gitakumar Parter Meeting
From: Wt charcs

Subject Sales Forecast
e May 1, 2009 142:17 AMPOT
o En Lo

> & 2Atlachmens, 769 KB (SaiE®) CGuEkTEa)

S

et f o nancal foracast o you 1 3 a ook at.

vt Rcnards

o “ Americas
1 “Asia

* Europe
= Afiica
= Ausralia
Other

Sales Forecast ppox (739 K8

See your Exchange folders,
notes, and tasks in Mail,
and use smart mailboxes
to locate special ones.

Use Spotlight to search
your Exchange messages.

Accept calendar
invitations in Mail.

Use Quick Look to
preview attachments.

Exchange 29



iCal
With iCal set up to access your Exchange server, you can accept and propose meetings
with other Exchange users. You can also manage your tasks.

Access your Exchange
calendars alongside
your personal calendars.

Propose meetings,
schedule conference
rooms, and invite
attendees from your
Global Address List.

Receive and respond to
meeting invitations.

30 Exchange



Address Book
Address Book gives you complete access to all your Exchange contacts, including your
Global Address List.

[ All Contacts
[ Exchange

[ 0n My Mac

v [ Exchange

[ Contacts
(i Engineering
(G Finance

[ Personal
Ul Review Team
Last Import

B Anne Johnson
L] Cindy Paxton
2] Darlene Weaver
[l Enrique Porter
(21 Jimmy Foster
[ Melissa Long
2] Chuck Brady

L Gita Kumar

(1] Sydney Bailey

|| Address Book

& Anne Johnson

work (555) 555-5555
cmall 1 annejohnson]@me.com

work 1234 Main Street
Cupertino, CA 95014

— Type here to search your
Global Address List.

— Update all the
information about your
Exchange contacts in
Address Book.

Your Exchange contacts
appear with your other
Address Book contacts.

Exchange 31
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Safari

200 Top Sites.
LLIGTo

TG Apvle Yahoo! Google Maps  YouTul SRR




Safari identifies your favorite sites and displays them in a stunning preview that makes it

easy to identify the sites you want to open.

800 Top Sites.

Ll dltloc o

0 & Apple Yahoo!

ire
! Coogle Maps YouTube Wikipedia News+ Populars

Click here to customize
Top Sites.

Click here to view
Top Sites.

To open a site, just
click its preview.

A star indicates
that a site has been
updated recently.
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Use full history search to flip through full page previews of webpages you have visited
and easily find one even if you don't remember the details of the site.

806 Top Sites.

Eheew ok Emes
Surfers’ Paradise

ey s St Sroekn

o Xk ok o 4

So you can see webpages
the way they looked when
you opened them, Safari
stores the text and images
of every page in your
history for one month.

To search your history,
click here and type
a word or two.



As you enter web addresses and searches, Safari quickly finds the best results and
provides other suggestions to help.

—— Safari offers excellent search
suggestions, courtesy of
Google Suggest and your
recent search history.

iPhone 3G

The fastest, most powerful iPhone yet.

[ XeXsl
(<[> )(+]0 wocons

Avple

Safari completes
the address with the
Top Hit and suggests

others from your

history and bookmarks.
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iChat

Make your chats more fun using video effects such as
backdrops. Show off your work with iChat Theater.

36 Chat



Use video backdrops with your chats to “be” anywhere in the world. iChat includes movies
and photos that you can use, and you can add your own.

Select a video backdrop
and then step out of the
picture for a moment.

Effects

Click Effects to select

a video effect.
Add your own movies

or photos to use as a
video backdrop.

37
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While you're in a video chat, you can select video effects to make your chats fun and
interesting.

ey Video Chatwith Ted Clark

Click the effect in the center
for the original view.

Pop Art

Click any effect to use it.



To show photos, movies, or presentations in a video chat, start the chat and then drag the
file or files to the chat window.

- YaYe) Video Chat with Ted Clark

unTy cosTs s
- ©
: ‘ ' 1aadil =
T e e e See how your

. presentation looks

to your buddy.

Effects

| Control your
presentation here.

39



Screen sharing lets you take control of a buddy’s computer to show how to do something,
rather than just explain it.

Click to switch
screens. To copy
a document to
this computer,
drag it here.

an6 My Home
o Anan::h:wn

© Bill James

o Gita's SMS.

@ Marta Ruiz

© Mei Chen

s Ted Clark

© Juan Chavez

Select a buddy with —
video chat capability,
and then click the
Screen Sharing button.




Tabbed chats

Use tabbed chats if you have a lot of chats. To do so, open the Messages pane of iChat
preferences, and then select “Collect chats into a single window.”

AIM M with Ted Clark <tclark3@me.com> _8/29/08 10:17 AM

Marta Ruiz

L®

e |2

. i Ghaves
I Gita
& Ravi Patel
" 107

See the latest reply

from your buddy.

— Click a chat to

return to it.

iChat 41
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QuickTime X




QuickTime Player provides simple controls to play a movie. So your movie can take center
stage, the controls fade from view.

Click here to watch
= your movie in full
= screen.

To see the controls, just move Click here to share your movie
the mouse pointer over the or to trim it.
movie window.
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Capture movies using QuickTime Player and the iSight camera built into your computer.

Movie Recording

To record a movie, choose
File > New Movie Recording,
set up your shot, then click
the record button.



Trim your movie to just the part you want to use, then share it with iTunes to use on
your iPhone, iPod, or Apple TV. You can also share your movie in a MobileMe Gallery
or on YouTube.

Rafting

Your movie to Tures
LRI

iPhone & iPod. O Apple TV
Sae 29M8. ke 9.7 M8 Ogamntte

| Drag the ends of the trim
area to select the part of the
movie you want to keep.

it it #hone, Pos, Appl TV, ant Computers o)

Select the size appropriate for where
you'll view the movie.
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Spaces




Turn on spaces in Exposé & Spaces preferences, and then press Fn-F8 to show your spaces.
To organize your windows, drag them from the current space to a different space.

COLOSSEU
ELEVATION DETAIL

Drag windows you want
to use together into the
same space.

47



48

To switch between spaces, press Control + [an arrow key]. To go directly to a space,
press Control + [a number key]. Arrange the order of spaces to suit your needs.

Drag spaces to
reorder them.

CoLossEuUM
ELevaTIoN Der

Use keyboard shortcuts
to quickly switch
between spaces.




After you turn on Spaces, you can add other spaces. You can also assign applications to
each space so that the application’s windows always open in the same space.

800 Exposé & Spaces

(Lo ) Cshowai ] q

Exposé | Spaces
Spaces lets you organize your windows into groups to reduce desktop clutter.

# Enable Spaces [ Show Spaces in menu ba

Rows: @ O

Coumns: @) ©

Application Assignments:

——— ol Space
1 Photo Booth.app Space 3
© ichatapp Every Space
8 icalapp. Space 4
\ Address Book.app. Space 3

TR
s and Mous Shoiis Ooe adehana sharcu choees,press S, Caner,Optonor Commane)
To activate Spaces: [ F8 W |- [~
o switch between spaces: [~ ArrowKeys 18]
To switch directly to a space: [ ~ Number Keys %

'When switching to an application, switch to a space with open windows for the application

®

— Add rows and columns to
create the spaces you need.

— To assign an application,
choose a space here or use
the shortcut menu in the Dock.

— Choose keyboard shortcuts
that work best for you.

Click the Add (+)
button to assign
applications to spaces.
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Mail
Use Apple-designed stationery to send gorgeous email
messages complete with photos.

Happy Birthday to You

I know you have a lot planned for your birthday and you're " ;
going to have a lot of fun. Look forward to secing you tonight. Thank You!
Thanks orthe fower the
Have a great day! e o o
Tracey Havea greatdayt

50 Mail



Stationery

When you create a message, select stationery to give it the perfect style whether the

occasion is fun or formal. Including photos is easy using the Photo Browser.

Click to see the

stationery you can use.

(<3

[=+] subject:

Favorites
Birthday
Announcements
Photos
Stationery.
Sentiments

— Select a type of stationery,
and then click the

stationery you want to use.

&) Photos.
(L) Summer Trip
[ Last 12 Months.

— Select photos from
iPhoto, Photo Booth,
or Aperture.

Fun, Fun, Fun

We're having a great time on our vacation. Yesterday we went to
beach in the morning. then we had lunch at a litte restaurant in
village. Excellent food! Later, we took a leisurely two hour horse|
ride through the country side. This is sure a beautiful place. After
headed back to the beach for reading and an afternoon siesta unds
the shade of the umbrella. The gentle ocean breeze was so calminy

— Locate photos here,
and then drag them to
your message.

Spash Smie

T

18 items
4

Mail
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Keep all your notes and to-do items in one place. Jot down reminders, shopping lists, and
information you need. Include pictures, URLs, and attachments with your items.

MAILBOXES
7 inbox
| onafts
o/ sent

|2 ToDo

vass
3 Apple Hot News

Notes (9 notes)

May 12,2000
May 11,2009
May 42000

922AM 5

New project

set up meefing with Juan
eed quest st

‘where should we have 7

need a caterer
oo

need this info to pick a date for the event
‘ will it be forwal or casual?

Ted says the art gallery is a nice place for parties
2 5/13/09  stop by gallery to diseuss

[ To Do Oprions |

Wil @ oue 0ate 51372009
© Alarm
Priority Medium
Calendar I calendar &

See your notes and to-do
items in the Reminders
section of the sidebar.

Click to create a
note or to-do item.

To create a to-do item,
select text in the note
and click To Do.

Click to set options for
the to-do item. Items
automatically appear in iCal.



Data detectors

You can turn dates in your email messages into iCal events. You can add names, phone
numbers, and addresses to your contacts. You can even map addresses in Safari.

Help Us Celebrate!

Mary's Birthday

‘Sunday, October 4, 2009. 2:00 PM

Children's Playground
1234 Main Street

Anytown, CA95014 K™ (- te New Contact.

Add to Existing Contact.

—— Move the pointer over the
date, name, or address, and
then click the triangle to
choose an action.

Mail
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Parental Controls
Give yourself peace of mind. Manage the time your children
spend on the computer and what they do there.

54 Parental Controls

N varia Weekday time limits
|
Allnws access 1o this computer L
< susan T oA el e forha
3 hours a day.
| ™ Limit computer use to:
|
Weekend time limits
m Allows aceess to er Saturday and Sunday for the
e ey
| 5 hous aday
M Limit computer use to: —
T, Bedtime
| ‘@; Prevents access to this computer during the specified hours.
|- g
# school nights: ~ 9:00 PM [ o 9:00AM @
Sunday - Thursday
4 weekend: 100 o (2] to 11:00AM [
Friday and Saturday
-
m Click the lock to prevent further changes.

@

To turn on parental controls, select a user account.

¥ Manage parental controls from another computer




Time limits

Manage when your children use the computer by setting time limits for weekdays,

weekends, and nights.

Parental Controls

o Marta

/“System  Content  Mail & iChat |- Time Limits | Logs

— Specify how many
hours a day your child
may use the computer.

1 cickne ok o prevesurverchanges.

Weekday time limits
Allows access to this computer Monday through Frday for the
¢ susan specifed number of hours only.
3 hours a day
# Limit computer use to:
= Weekend time limits
Allows access to this computer Saturday and Sunday for the
specified number of hours only.
5 hours a day
# Limit computer use to: —_
Bedtime
Prevents access o this computer during the specified hours.
#school nights:  9:00 P (3] 10 9:00 A 3]
Sunday - Thursday
 Weekend: 11:00 P (3} 10 11:00 am 3]
= Frday and Saturday

— Specify the hours during
which your child may not
use the computer on school

®

nights and weekends.

Parental Controls
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Content limits

To limit the websites your children can visit on the Internet, click Content and then select

the level of restrictions you want to apply.

parental Controls

B Marta
# susan

{ System [SGonteE Mai & iChat _Time Limits __Logs

Website Restrictions

Restricts website access to sites with
appropriate content or toa s of websites.

(1 Hide profanity in Dictionary.
Limits access to centain words in
the Mac 05 X dictionary.

O Allow unrestricted access to websites.

Select this to try limiting
access to adult websites.
Click Customize to specify
websites your children can
and cannot visit.

O Try to limit access to adult websites

("Customize... )

© Allow access to only these websites

@ Discovery Kids
@ Fas ks

4 HowstuffWorks
 Natonal Geographic - Kids
 vahoo! kids

4 Disney

@ scholasticcom

#4 Smithsonian Institution
 Time for Kics

- (-]

1 cickne ok o prevensurverchanges

— Select which websites your
children can visit.
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Mail and iChat limits
Protect your children from unwanted communication by specifying who they can chat

with and exchange email with.

Time Limits | Logs }—

[ System | Content

7 Marta LimitMail @ Limit iChat
f Uit chatand emall exchanges o the
¢ Susan addresses added to tis .
Only allow emailng and instant messaging it
Email &

okumar@me.com
ravipatel@me.com -1
jehavez4@me.com

annejohnsonigme.com

()Send permission requests t: Enter your email address to be
exchange emall with 3 Contact who 1 not i the approved st. notified if your children try to
o correspond with someone who
ekl v e Ao STE )
isn'tin the list.

Click the Add (+) button to
add an address.

Parental Controls
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Photo Booth




“Be” anywhere in the world—or out of this world—by using backdrops when you take

a snapshot.

Photo Booth
Select a backdrop, and then

step out of the picture for
a moment.

Color Dots: ’ Eanhrlsﬁ

Eiffel Tower: 4 8 Normal

\\ P |

Wik g
Sunset

Rollercoaster s =} Yosemite

o EE) sEms [« = »)

[aEmaaal

19 photos and 2 movies
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Now you can make a burst of four snapshots. You can export a 4-up snapshot as an
animated GIF to use as your buddy picture in iChat.

Photo Booth

When previewing
a 4-up snapshot,
click a frame to
preview that
frame and select
how to use it.

|(eMs) Q

| T

Click the 4-up
button.

32 photos and 1 movie




Make a movie of yourself using effects and backdrops. Use your movie as a video greeting,
complete with audio, to send to your friends in an email message.

When you preview
a movie, move the
pointer over the
image to control
— = = playback.

Click the Movie
Clip button.
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Boot Camp
To use a Windows application on your Mac, install Boot Camp
and your copy of Windows. Then you're ready to go.
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Install Boot Camp
Open Boot Camp Assistant (in the Utilities folder in the Applications folder) and print the

Boot Camp Installation & Setup Guide. Then create a partition for Windows.

Introduction

The Boot Camp Assistant helps you install Microsoft Windows XP or
hased M: s

Windows Vista operating systems on an Intel-!

Print the Boot Camp Installation & Setup g
Windows. You'll need this document to cof o .
Create a Partition for Windows.

IMPORTANT: Back up your disk before pal
Windows. If you are installing Windows on — . .
N e oo Each operating system requires its own partition on the disk.

Drag the divider to set the size of the partitions, or click one
of the buttons.

) “Macintosh HD" will be partitioned as:

S
Mac 05 X Windows
227c8 5B
190 GBfree

Divide Equally ) (  Use 32 GB. D

(Print Installation & Setup Guide

Print this document to
. . Go Back | (_Partition )
follow the instructions (o )

while installing Windows.

Drag the divider to
set the size of the
Windows partition.

If you installed a beta version of Boot Camp, you only need to install the new Windows
drivers by switching to Windows and inserting the Snow Leopard installation disc.
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Install Windows
Insert your Windows XP or Windows Vista installation disc and click Start Installation.

Start Windows Installation

Insert your Windows installation disc and click Start
Installation.

You'll need an authentic 32-bit Microsoft Windows XP Home
Edition or Professional with Service Pack 2 or later, or
Windows Vista Home Basic, Home Premium, Business, or
Ultimate disc.

After you have installed and set up Windows, insert yourMac  ——— |nstall the Windows drivers
05 X install disc to install additional drivers and other

software for Windows. when you finish installing
and setting up Windows.

(_Quit & Install Later ) ( Gogack ) (_startinstallation )

Click when you're ready
to install Windows on
your Mac.

To install Windows software on a MacBook Air, you need an external optical drive such as
a MacBook Air SuperDrive.
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In Mac OS X, open Startup Disk preferences to select your Windows partition. In Windows,
open the Boot Camp Control Panel and then click Startup Disk.

Startup Disk

Select your Windows
partition and then click
Restart.

Windows Network Startup
an BOOTCAMP

‘You have selected Windows
R

B Boot Camp Control Panel

Click to restart this computer in targ
After you restart this computer in target di
to another computer using a FireWire cable|

Startup Disk | Brightness | Remote | Keyboard | Trackpad | Power |

Select the systam you want o use to stark up your computer:

fl
d Click the lock to prevent further cf = e— 'l

Select your Mac OS X
startup disk and then

click Restart.

Macitosh HD  BOOTCAMP J

Click to restart this computer in Target Disk Mode,

e youestrt the conputer Tt Dk e, you cen conpect &

to another computer Lsing a FirelWire cable and use it 3s a hard disk.

e le—al & e
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Here if you need us

www.apple.com/support
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Online resources

For online service and support information, visit www.apple.com/support. Choose
your country from the pop-up menu. You can search for the latest software updates
and manuals, find answers using the AppleCare Knowledge Base, or get help from
Apple’s discussion forums.

Onscreen help

You can find answers to your questions, as well as instructions and problem-solving
information, by using the Help menu in some applications. Choose Mac Help from
the Finder Help menu, type a few words in the search field, and then press Return.

System Profiler

Use System Profiler to retrieve information about your computer. System Profiler
indicates the hardware and software installed on your computer, the serial number
and operating system version, the amount of memory installed, and how much
battery power remains. To open System Profiler, choose Apple (&) > About This Mac
from the menu bar, and then click the More Info button.



Your Mac OS X product comes with 90 days of complimentary telephone support.

AppleCare telephone support representatives can help you solve basic problems.
Contact the support center nearest you, or visit www.apple.com/support/expert to
arrange a phone call with an Apple Expert who specializes in your exact question
(not available in all countries). Have the date of purchase and your Apple computer
serial number ready when you speak to a representative.

Note: Telephone fees may apply. For more information, visit www.apple.com/
support/complimentary.

You can extend your coverage by purchasing the AppleCare Protection Plan.
For more information, visit www.apple.com/support/products.

For additional information about contacting Apple Support, visit www.apple.com/
contact/phone_contacts.html. (Telephone numbers are subject to change.)

Technical Support Numbers

United States 1-800-275-2273 www.apple.com/support

Canada 1-800-263-3394 www.apple.com/ca/support
Australia (61) 1-300-321-456 www.apple.com/au/support
New Zealand 00800-7666-7666 www.apple.com/nz/support
United Kingdom (44) 0870 876 0753 www.apple.com/uk/support
Ireland (353) 1850 946 191 www.apple.com/ie/support
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